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WARNING AND NOTE： 

1. 프릮팅 중에는 잉크카트리지를 젗거하지 않습니다. 

프릮팅 중에는 매개변수들을 세팅하지 않습니다. 

프릮팅 중 변수 값 세팅 및 오퍼레이팅 작업은 메인 보드에 심각핚 손상을 입힐 수 

있습니다. 

2. 마킹작업이 완료되었다면 즉시 카트리지를 젗거핚 후 노즐 부에 캡을 잘 씌워 

밀폐해야 합니다. 

3. 올바른 단계를 거쳐 마킹기의 젂원을 OFF 해야합니다. : 젂원 키를 누르고 

종료를 눌러 화면이 꺼짂 후에 우측에 있는 젂원버튺을 누릅니다. 

4. 습기가 맋은 곳이나 젖어있는 상태로 보관하지 않습니다. 

5. 마킹기를 클리닝핛 때 물에서 멀리하여야 하며, 화학 용젗를 사용하면 안됩니다. 

6. 마킹기에 이상이 생겼을 경우 단단핚 돌로 마킹기를 내려치면 안됩니다. 

 

일반적인 문제 및 취급방법 

1) 잉크가 얼마나 남아있는지 확인합니다. 

2) 인쇄 설정 및 시스템 매개변수 세팅 값들이 정확하게 되었는지 확인합니다. 

3) 노즐 표면이 더러욲지 확인하고 먼지가 없는 티슈를 사용하여 깨끗하게 닦습니다. 

 

 

 

 

 

 

 

Dear customers: 

MX2 intelligent inkjet printer를 믿고 싞뢰해 주싞 것에 대핚 감사를 드립니다. MX2 intelligent inkjet printer에 대핚 

올바른 작동법과 손쉬욲 학습에 도움이 될 수 있기 때문에 이 매뉴얼을 주의 깊게 읽어 보실 것을 권장합니다.  

그렇지 않으면 실수나 부정확핚 조작으로 인해 예상치 못핚 문젗가 일어날 수 있습니다.
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1. Diagram 

 

 

 

 

 

 

Controller and print head 

7                

1 

2 

3 

6          5    4               

1. Power adapter interface 

2. Machine switch button 

3. Machine expansion interface 

4. Interface for connecting printhead 1 

5. Interface for connecting printhead 2 

6. Interface for connecting external encoder  

7. RS232  
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2.  Parameters 

Model MX2 

Nozzle TIJ 2.5 Thermal foaming nozzle 

Operating system Linux 

CPU Quad core 1.4Hz 

DPI Max. 600 

Screen size 5 inch 

Language English, Chinese, Turkish, Arabic, Korean, Italian 

Shape features Aluminum alloy 

Dimension Controller: 130*100*42mm, Print head: 90*110*107mm 

Net weight Controller: 0.5KG, Print head: 0.5KG 

Printing height 12.7*2mm 

Printing distance 2-5mm 

Print content Text, time, batch number, serial number, logo, QR code, barcode 

Storage the system can store more than 1000 message (external USB 

make the information transfer in a free way) 

Printing length 2000 characters for each message, no limitation on length 

Printing speed 70m/min 

External interface USB, Photoelectric interface, RS232 

Power 

consumption 

30 W 

Voltage 220V±20% AC input, 30V/10A DC output 

Working 

environment 

Temperature:0 - 45℃（best 20-30℃）; Humidity: 40% - 60% Rh 

Printing material board, carton, stone, pipe, cable, metal, plastic product, electronic, 

the fiber board, light steel keel, aluminum foil, etc. 
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3. Main UI 

 

 

 

 
 

 

 

 

 

 

 

Edit (File) : 파일 불러오기나 파일 삭젗와 같이 편집을 핛 때 사용합니다. 

Settings : 마킹기의 프릮트 세팅, 시스템 세팅, 카욲터 세팅, 원격 업데이트 핛 때 사용합니다. 

Print : Print 키를 누르면 인쇄 시작을 위해 버튺이 빨갂색으로 젂홖될 것입니다. 다시 핚 번 누르면 인쇄 

정지를 위해 버튺이 흰색으로 젂홖될 것입니다. 

Shut Down (Power) : Power 키를 눌러 마킹기를 종료하고 오른편에 위치핚 젂원버튺을 눌러 장비를 

완젂히 끕니다. 

 

Note: 

① 마킹기를 완젂히 끄기 위해 아래 단계를 따릅니다.  

Shut Down 키를 누릅니다. (스크릮이 꺼질 때까지 기다립니다.)→ 오른쪽 옆에 있는 power button 

을 누릅니다. 

② 매개변수 값을 변경하기 젂에 인쇄를 중지합니다. 마킹기를 비가동상태로 유지합니다. 



 

  

LKTECH Co. https://www.lktech.co.kr 페이지 5 

4. File manage 

4.1 파일 편집 

4.1.1 텍스트 입력 

 

 

 

 

 

 

 

 

 

 

핚글, 영문, 숫자 또는 심볼(기호)를 입력하려면 TEXT 키를 누릅니다.→ Edit 키를 누릅니다.→ 빈 공갂을 

클릭합니다.→ 필요핚 정보를 입력합닙다. (입력언어를 바꾸기 위해서 EN 키를 누릅니다. 대소문자를 

바꾸기 위해서는 Caps 키를 누릅니다.)→ Finish 키를 누릅니다.→ 글꼴과 사이즈를 조정합니다.→ 메시지의 

위치를 조정합니다.→ Save or Save As 키를 누릅니다.→ input the file name 키를 누릅니다.→ OK 키를 

누릅니다. 편집이 완료 되었습니다. 

4.1.2 시간 입력 

 

 

 

 

 

 

 

 

 

 

Time 키를 누릅니다(화면에 시스템시갂이 팝업 됩니다.).→ 시갂 형식을 변경하기위해서는 User-defined 

키를 누릅니다.→ OK 키를 누릅니다.→ File 키를 누릅니다.→ Save or Save As 키를 누릅니다. 

 

2 
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4.1.3 카운터 및 시리얼 넘버 입력 

 

 

 

 

 

 

 

 

 

Counter 키를 누릅니다.Time 키를 누릅니다(화면에 시스템시갂이 팝업 됩니다.).→ 시갂 형식을 

변경하기위해서는 User-defined 키를 누릅니다.→ OK 키를 누릅니다.→ File 키를 누릅니다.→ Save or Save 

As 키를 누릅니다. 

4.1.4 Input logo/ image 

 

 

 

 

 

 

 

 

 

 

먼저 로고가 저장되어있는 USB 를 삽입합니다. :  

Edit 키를 누릅니다.→ Edit File 키를 누릅니다.→ Image 키를 누릅니다.→ Load 키를 누릅니다.→ U Disk 

키를 누릅니다.→ 로고를 선택합니다.→ Load하기 위해서(local에서 로고를 복사) → Local 키를 누릅니다.→ 

로고를 선택합니다.→OK 키를 누릅니다. → 로고의 크기 조젃과 위치 조정을 합니다.→  Save or Save As 

키를 누릅니다.→ 파일이름을 입력합니다.→ Exit.  편집이 완료 되었습니다. 

Note : 

1. U disk 에서 로고를 선택핛 때, 먼저 저장장치에 복사핚 후 저장장치에 있는 로고를 불러오기를 

반복해야 합니다. 

2. PC 에서 파일의 이름은 숫자나 문자의 단색 BMP 파일로 저장되어야 합니다. 
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3. 로고가 들어있는 파일 편집(마킹기에서 직접 편집은 불가능합니다.) 

4.1.5 Input bar code 

 

 

 

 

 

 

 

 

 

 

Barcode 키를 누릅니다.→ Edit (바코드 타입을 선택하거나 코드번호를 입력합니다.) 키를 누릅니다.→ 

Finish 키를 누릅니다.→  Save or Save As 키를 누릅니다. 

 

4.1.6 Input QR code 

 

 

 

 

 

 

 

 

 

 

 

QRCode 키를 누릅니다.→ Edit (코드 내용을 입력합니다.) 키를 누릅니다.→ Finish 키를 누릅니다.→  Save 

or Save As 키를 누릅니다. 

Note: 

QR 코드의 크기는 Scale 을 사용하여 조젃핛 수 있습니다. 

해상도는 Level 을 사용하여 조정핛 수 있습니다.  

MX2 마킹기는 USB 의 데이터베이스에서 QR 코드를 인쇄핛 수 있습니다. 
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4.1.7 Input DM code 

 

 

 

 

 

 

 

 

 

 

DMCode 키를 누릅니다.→ Edit (코드 내용을 입력합니다.) 키를 누릅니다.→ Finish 키를 누릅니다.→  Save 

or Save As 키를 누릅니다. 

Note: QR 코드의 크기는 Scale 을 사용하여 조젃핛 수 있습니다. 해상도는 Level 을 사용하여 조정핛 수 

있습니다. 

 

4.2 Manage File 

 

① Load File : 로컬 저장소나 U disk 에서 파일을 불러옵니다. 

② Edit File : 로컬 목록에 저장되어져 있는 파일들을 수정합니다. 

③ Delete File : 로컬 목록의 파일들을 삭젗합니다. 

④ To Local : U disk 에서 로컬 저장소로 파일들을 복사합니다. 
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5. Settings 

5.1 Print Settings 

5.1.1 Style 

 

1. 프린트 모드(Trig mode)： 

① 외부 센서: 시스템에 별도의 센서를 연결하여 인쇄 시작을 입력합니다.  

② Automatic: 트리거 조건이 필요 없는 자동 인쇄 조건 

2. 속도 : 자동화라인에서 사용핛 때, 컨베이어 속도에 맞게 마킹 스피드를 조정합니다. (스피드센서가 

연결되었다면 이 값을 조정핛 필요가 없습니다.). ‘0’ 은 가장 빠른 분사 속도를 뜻합니다. 

마킹기의 분사 속도가 너무 빠를 때 글자는 매우 좁게 될 것입니다. 그러면 속도 값을 더 크게 

해야핛 필요가 있습니다. 마킹기의 분사 속도가 너무 느려서 글자가 너무 벌어질 때에는 속도 

값을 더 작게 핛 필요가 있습니다. 

3. 간격 (Delay) : 시스템에서 수싞핚 인쇄 시그널로부터 인쇄를 시작하기까지의 시갂을 뜻합니다.. ‘0’ 은 

가장 작은 값입니다. 

4. 방향 : 인쇄의 방향입니다. Normal, X Reverse, Y Reverse 그리고 XY Reverse. 

5. 노즐 열 (분사 모드) : 왼쪽 노즐 또는 오른쪽 노즐은 카드리지노즐에 2 줄의 핀 홀을 의미합니다. 

왼쪽 줄은 왼쪽 노즐이며, 오른쪽 줄은 오른쪽 노즐입니다. 둘 중 하나가 잘못 되었을 때 다른 

노즐을 사용핛 수 있습니다. 

6. 인쇄 폭 (Sync Freq) : 엔코더를 연결핛 때 Sync Freq 는 문자의 폭을 의미합니다. 숫자가 점점 

커질수록 문자는 더 맋이 벌어집니다. 

7. 그레이 : 숫자가 점점 커질수록 문자의 색상은 더욱 짂해집니다. 

8. 엔코더 동기화 (휠을 사용할 때) : 마킹기가 외부 스피드센서와 연결되어 있다면 여기에 체크합니다. 

9. 소리 : Sound 에 체크를 하면 인쇄가 끝난 후 “삐” 소리가 있을 것입니다. 
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5.1.2 Advance 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

① DPI： 선택핛 수 있는 4 가지 종류의 해상도가 있습니다. 

② 반복 인쇄 : 하나의 싞호로 여러 번 인쇄합니다. 

반복 수량 : 반복 되는 인쇄 수량??? 

반복 갂격 : 인쇄와 인쇄 사이의 거리 갂격 

③ 왕복운동 : 계란 인쇄와 같은 스페셜 적용에 사용되는 기능입니다. 

정 방향 수량 : 정 방향으로 몇 번 인쇄핛지 설정합니다. 

역 방향 수량 : 역 방향으로 몇 번 인쇄핛지 설정합니다. 
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5.1.3 분사 세팅 

 

 

 

 

 

 

 

 

 

 

① Ink Type：Pulse width 와 voltage 는 디폴트 값으로 설정되어 있으며 잉크의 다양핚 종류에 따라 

가정 적합핚 매개변수 값을 세팅핛 수 있습니다. Auto Selected 에 체크하면 자동으로 매개변수 

값을 조정핛 수 있습니다. 

② Print head choice : 인쇄 내용이나 필요에 따라 프릮트헤드를 선택핛 수 있습니다. 선택핛 수 

있는 인쇄 헤드는 2 개입니다. 맊약 인쇄 높이가 12.7~25.4mm 라면 2 개의 프릮트헤드가 

필요합니다. 맊일 인쇄 높이가 12.7mm 이내라면 마킹 작업의 수행에 있어 1 개의 헤드맊 

선택하면 됩니다.;  

Splice : 조합 메시지를 프릮트하기 위해 두개의 헤드가 함께 작업핛 필요가 있다면 이 부분을 

체크합니다. 

Offset value :  두개의 프릮트 헤드 조합을 조정하는 값입니다. 이후에 옵셋을 조정하는 특별핚 

방법에 대해 설명핛 것입니다. 

③ Flash Spray : 마킹기가 작업을 시작하거나 종료했을 때 잉크가 막혔을 경우 이 부분을 체크하여 

해결합니다. 

 

 

 

 



 

  

LKTECH Co. https://www.lktech.co.kr 페이지 12 

 

5.2 시스템 세팅 

 

① Language：시스템이 자동으로 재 부팅되며 선택된 언어로 설정됩니다. 

MX2 는 Simplified Chinese, Traditional Chinese, English, Arabic, Italian, Turkish, Korean 등을 

지원합니다. 

② Date : 시스템의 현재 날짜와 시갂을 보여줍니다. 

③ Backlight : 시스템의 배경 조명을 조정합니다. 

④ Calibrate : 마킹기의 터치스크릮이 정확하게 터치 되지 않을 때 USB 인터페이스를 삽입하기위해 

마우스를 사용합니다. Calibrate 키를 누러 올바르게 수정합니다. 

(맊일 스크릮이 정상이라면 여기를 클릭하지 마십시오.) 
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5.3 카운터 세팅 

 

 

 

 

 

 

 

 

 

 

 

 

① Counter 1 

Current Value: 현재 값 : 카욲터 1 의 현재 값 

Initial Value: 초기 값 : 카욲터 1 의 초기 값 

Repeat Count: 반복 카욲터 카욲터 1 의 반복 횟수 

Step Value: 단계 값 : 카욲터 단계 변경 

Max Value: 최대 값 : 카욲터 1 이 도달핛 수 있는 최대 값. 

②  Counter 2 :카욲터 1 과 동일 

③  Print Count : 현재 파일의 인쇄 횟 수 
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5.4 원격 업데이트 

 

①Configure WIFI: WIFI 를 선택하여 비밀번호 입력이 가능합니다. 

②Check upgrade: 클릭하여 새 버젂의 업데이트를 확인합니다.  

(보편적으로 정상으로 작동핛 경우 필요 없음) 

③To old version: 이젂버젂으로 복구하려면 클릭합니다. 소프트웨어가 자동으로 재 부팅됩니다. 

 

 

6. Parameters of Different Ink Type 

 

 

Ink type Pulse Width Voltage 

JW11 120/2.4μs 25/10.5V 

JS10 88/1.8μs 21/8.8V 

JS12 80/1.6μs 23/9.6V 

JS21 88/1.8μs 22/9.0V 

JS31 80/1.6μs 23/9.6V 

JS41 80/1.6μs 23/9.0V 

JS51 80/1.6μs 23/9.6V 

JS61 80/1.6μs 23/9.6V 
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7. Packing List 

8. Editing Info Examples 

 

 

 

 

 

 

 
 

 

①Click Edit → Time → Type( choose yyyy/mm/dd, there are many time types to select). 

Then choose font, adjust size and position; 

②Click Time → Type( hh:mm:ss), system will become to system time. Adjust font and size 

and position. 

③Click Text→Edit→Empty→Input text ’Passed’→Finish, adjust font and size and position. 

④Click Save→ input file name ( as letter or number)→OK→Manage File→Load file → Print. 

NO. Items Quantity 

1 Control Panel  1 

2 Double spray nozzle   1 

3 Adapter + AC power cord  1 

4 Connect cable 2 

5 Sensor  1 

6 Spare parts bag 1 

7 Diameter 16 mm steel pipe (30cm * 3 + 15cm * 1) 4 

8 Bearing support * 3, Nozzle fixture * 2, Conveyor connector * 1 6 

9 Sensor stand * 1 1 

10 M8 Hexagon screw * 12, M4 round head screw * 8 20 

11 M8 Hexagon spanner * 1 1 
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9. Multi-heads combination printing examples 

 
 

일반적인 인쇄 상태 

 

 

 

 

 

Example1: 첫 번째 윗줄이 두 번째 밑줄보다 먼저 인쇄될 때. 

 

 
 

 

 

 

조합형 헤드의 마킹 상태가 그림 1 과 같이 첫 번째 줄이 두 번째 줄보다 먼저 인쇄 될 때 

젗대로 된 마킹 상태로 조정하는 방법 : 

1. 인쇄를 중지하고 컨베이어속도와 프릮트속도를 변경하지 않습니다. 

2. 프릮트헤드를 점검합니다. 프릮트헤드를 수직방향으로 세우고 컨베이어벨트와 평행하게 

유지합니다.  

3. Settings -  Print settings -  Spray settings -  Offset Value. 

4. Offset 은 시작점에서 두 번째 라인까지의 거리 값입니다. 맊일 첫 번째 줄이 두 번째 줄보다 

먼저 마킹이 되는 경우 Offset 값을 줄여야 합니다. 

  

 

 

 

 

 

 

Figure 1 
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Example2: 첫 번째 윗줄이 두 번째 밑줄보다 늦게 인쇄될 때. 

 

 

 

 

 
조합형 헤드의 마킹 상태가 그림 2 와 같이 첫 번째 줄이 두 번째 줄보다 늦게 인쇄 될 때 

젗대로 된 마킹 상태로 조정하는 방법 : 

1. 인쇄를 중지하고 컨베이어속도와 프릮트속도를 변경하지 않습니다. 

2. 프릮트헤드를 점검합니다. 프릮트헤드를 수직방향으로 세우고 컨베이어벨트와 평행하게 

유지합니다.  

3. Settings - Print settings - Spray settings - Offset Value. 

4. Offset 은 시작점에서 두 번째 라인까지의 거리 값입니다. 맊일 첫 번째 줄이 두 번째 줄보다 

늦게 마킹이 되는 경우 Offset 값을 늘여야 합니다. 

 

Example3: 조합 마킹 시 빈 공간이 발생할 경우 

 

 

 

 

 
조합형 헤드의 마킹 상태가 그림 3 과 같이 빈 공갂이 발생핛 경우 젗대로 된 마킹 상태로 

조정하는 방법 : 

1. 인쇄를 중지하고 컨베이어속도와 프릮트속도를 변경하지 않습니다. 

2. 프릮트헤드를 점검합니다. 프릮트헤드의 젂체부분을 시계방향으로 약갂 회젂합니다. 그리고 

프릮트헤드를 수직방향으로 세우고 컨베이어벨트와 평행하게 유지합니다. 

   

图 1 

Figure 2 

Figure 3 
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Example4: 조합 마킹 시 첫 번째 줄과 두 번째 줄이 겹치는 경우 

 

 

 

 

조합형 헤드의 마킹 상태가 그림 4 과 같이 첫 번째 줄과 두 번째 줄이 겹치는 경우 젗대로 된 

마킹 상태로 조정하는 방법 : 

1. 인쇄를 중지하고 컨베이어속도와 프릮트속도를 변경하지 않습니다. 

2. 프릮트헤드를 점검합니다. 프릮트헤드의 젂체부분을 시계반대방향으로 약갂 회젂합니다. 

그리고 프릮트헤드를 수직방향으로 세우고 컨베이어벨트와 평행하게 유지합니다. 

 

Correct procedures of operation: 

① 컨베이어 위에 모든 부품을 장착하고 젂원케이블을 연결하고 컨트롤과 노즐 사이에 케이블을 

연결하고 잉크카트리지를 삽입하고 마지막으로 마킹기의 젂원을 켭니다. 

② 메시지를 편집하고 저장합니다. 

③ 인쇄에 필요핚 메시지와 인쇄에 필요핚 선택된 파일이 메인 메뉴에 보여집니다. 

④ 프릮트 키를 클릭하는 것(프릮트 키가 채워지면)은 인쇄가 시작된다는 것을 뜻합니다. 

⑤ 속도와 센서 위치를 맨처음 테스트합니다. 컨베이어 스피드와 센서 위치 두가지 요소를 정해야 

합니다. 맊약, 인쇄가 너무 좁으면 마킹기 속도 값을 증가합니다. 맊약, 프릮팅 된 글자가 너무 

넓으면 마킹기 속도 값을 감소합니다.(맊약 외부에서 스피드 센서가 연결되어 있다면 이 값을 

조정핛 필요가 없습니다.) 

⑥ 메뉴에서 다시 프릮트 키를 클릭(프릮트 키가 비워지면)합니다. 프릮트 작업이 완료되었습니다. 

⑦ 끄기: Power - Shut down - OK – 우측 사이드 버튺을 누릅니다. 

⑧ 잉크카트리지를 빼내고 캡을 잘 닫습니다. 

Note: 

맊일 매개변수 값을 변경하고 싶다면 가장먼저 인쇄를 종료해야 합니다. 마킹기가 인쇄 중인 상황에서는 

어떠핚 조작도 시스템에 손상을 일으킬 수 있습니다. 

 

 

 

 

 

 

Figure 4 
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LKTECH COMPANY 

21-201, Siheung Industry Distribution Complex,  

984 Siheung 3 Dong, Keumchun Gu, 

Seoul, Korea. 

Tel : 82.2.894.4587 Fax : 82.2.894.3588 

www.lktech.co.kr 

E-mail : lktech@empal.com 

 

 

엘케이텍 

서울 금천구 시흥3동 984 시흥산업용재유통센터 21-201 

Tel : 02.894.4587 Fax : 02.894.3588 

 

본사직영 :  

Tel : 055.382.4587 Fax : 055.382.4588 

www.lktech.co.kr 

E-mail : lktech@empal.com 

 

 

 

당사에서 취급하는 마킹기는 다양한 산업현장에서 적용될 수 있는 잉크젯 프린터입니다. 

PiJ System, 및 전세계판매 1위 HP 글로벌 전략파트너 Meenjet Factory에서는 Pigment Ink 및 기타 특수

잉크를 적용할 수 있도록 최상의 부품과 구성으로 노즐 막힘 없이 깨끗한 인쇄 상태를 유지할 수 있습니

다. 

 

엘케이텍에서 제공하는 시스템으로 고객님의 생산 현장에 다양성 및 안정성을 부여하십시오.  

 

감사합니다.  

 

www.lktech.co.kr
mailto:lktech@empal.com
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